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Experiment No.5: Introduction to IoT and Android Application development

Objective: To introduce learners to the fundamentals of the Internet of Things (IoT) and

Android-based application development.

Outcome: = Learners explore the loT-enabled ESP32 module and temperature sensor -
DHT22 by interfacing them and interpreting the displayed results on a
hyper terminal.

= Learners use an example web based IoT interface platform, ‘Thingspeak’,
and display real-time temperature and/or humidity readings for remote
access.

» Learners develop an understanding of the open-source Android
development platform, MIT App Inventor, by creating a sample app that
displays and announces a given message.

Tasks 1) Introduction to the concept and technology of Internet of Things (IoT).

Problem

Statement, 2) Introduction to ESP32.

Procedure,

Observation | Kindly Note: The Arduino IDE rigorously requires, regular updates. Hence

, Discussion, | it is very much advisable to ensure basic internet connectivity before

and Report: | proceeding with the activities.

Activity 1: Blink on board LED
Follow the steps below very carefully:
a) ESP 32 Dev Kit v1: Pinout
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b) The ESP32 can be programmed using different firmware and programming
languages, like:

Arduino C/C++ using the Arduino core for the ESP32
Espressif IDF (IoT Development Framework)
Micropython
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JavaScript etc.

We shall be using Arduino IDE and C type programming language to code and
program the ESP32.

c¢) The latest version of Arduino IDE viz. v 2.3.3 has already been installed on
your computer terminals.

d) One also needs to install the CP210x USB to UART Bridge Virtual COM
Port (VCP) drivers. This allows communication with the Arduino compatible
boards, ESP 32 in this case, to communicate on the USB port.

e) Configure the Arduino IDE on the terminal for ESP 32 board:
From within the IDE select the option “Select Other Board and Port”

1@ sketch nov16a | Arduino IDE 2

D sketch_novigaino

1 veid setup() {

Select Other Board and Port
2 // put your setup cod

& w

¥

void loop() {
/1 put your main cods

® 0w e

} dey xQ

"

P % B

v | COM3 Serial Port (USB) v

() €

In the search menu, search for the board ‘ESP 32 Dev Kit V1°. As shown select
— DOIT ESP32 DEVKIT V1, as the board.

Also select the corresponding COM (communication port for serial
communication over the USB port) port. - COM3 as above.

(This may differ from terminal to terminal and may require one to verify from
the ‘Device Manager’, in Windows for obtaining the right serial port assigned
to the board connected from the various available)

Search — Device Manager in the Windows, Search bar and locate the right COM
port as shown, from the — Ports (COM & LPT) menu.
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ﬁ Device Manager -

File Action View Help

&= B = EX®

> Q Cameras
> Computer
> s Disk drives
> [l Display adapters
> ; Firmware
> Human Interface Devices
> o Imaging devices
> 2 Keyboards
> Bl Memory technology devices
> a Mice and other pointing devices
> [ Monitors
> [ Network adapters
> E? Other devices
~ & Ports (COM & LPT)
E Silicon Labs CP210x USB to UART Bridge (COM3)
> = Print queues
> n Processors
> WY Security devices
~ [@ Sensors
5 HID Sensor Collection V2
5 HID Sensor Collection V2
B HID Sensor Collection V2
B HID Sensor Collection V2
E Microsoft Visual Studio Location Simulator Sensor
> r Software components

s B cafthwara dovicac

f) Now from the File menu in the IDE, select Examples > 01 Basics > Blink
& skelth_novlBa| Arduino IDE 236 Bullt-n examples - o X
s o o [y

MNow Cloud Sketch  Alt+Ctrd=N

03.Analog ? Bt
Open. o 4 Commurication > DigitalReadserial
Open Recent > 05 Control > Fade
Sketehbook ’ 06 Sensors > ReadAnzlogyoltage
Examples > 7.Display >
Close Gl 08.Strings g
sae s 03.usp >
Save A Clrlshites 10.Starterkit_BasicKit >
Preferences Cul+Comma Thrdinols? ’
J— N Examples for DOIT FSP32 DEVKIT VT
ArduinoGTA >
Quit cela BLE ?
EluetaothSerial >
DNSServer >
EEPROM 4
ESP Insights >
ESF RainMaker 4
ESP_2S >
ESP_NOW 4

In, Col 1 DOITESP32 DEVKIT V:

As seen below the example code file Blink.ino, made available in public
domain, gets opened:
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@ slink | Arduino IDE 23.6 a X
file Edit Sketch Tools Hel

2 0 6 DS +o

Blinkina
11
12
13

Ln 1, Col 1 DOIT ESP22 DEVKIT V1 on COM3 D

Few points to be noted:
e Arduino Files of code or program are text files, called as ‘sketch’ and
are saved by the default extension .ino
e Every Arduino program or sketch consists of two functions:

setup () {

}

and
loop () {

e Upon compilation and during execution, the setup () function executes
only once, whereas the loop () function executes continuously. Thus the
setup () function is expected to contain the initialisation code, whereas
the loop () function contains the body of the program functionality.

e Arduino programs have a C — type structure. Thus the body of the
function is enclosed in brace brackets {.....} and every statement ends
with a semicolon ;

g) With the board connected, right board and port selected in the terminal and
the above example i.e. Blink.ino being opened, make the following changes in
the program before compilation and upload on the board.

Replace LED_BUILTIN by the ESP 32’s built-in LED’s 1/O port pin — 2
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@ 8link | Arcuine IDE 2.3.6 o X

file Fdit Sketch Tools Help

2 © 6 DI res

Blink.ino
11
12
13
14
15
16
17
18
19

21

tup() {

Mode(2, OUTPUT);

Ln 21, Col 1 DOIT ESP32 DEVKIT V1 on COM3 0

Verity (Compile) the code by clicking on the ‘tic’ icon at the top left of the IDE.
Upon receiving no errors
Upload the code by clicking on the ‘right arrow’ icon.

& Blink | Arduino IDE 2.36 =] X

File Edit Sketch Tooks Help

206 o

glj Uoload

11
12
6
18 -
20
21
23

26 void setup() {
27

Output
rFiting & 2 78.9% 112 86 Dytes...

Writing at @x0@e4cBss > ] 99.2% 131 5385 bytes...

Writing at @x@@e51838 =] 166.@% 145386/145386 bytes...
Wrote 268336 bytes (145386 compressed) at @x@6@18686 in 2.2 seconds (966.6 kbit/s).

Hash of data verified.

Hard resetting via RTS pin...

Ln 18, Col 18 DOITESP32 DEVKITViencOM3 32 5

As seen and reflected in the code the in-built LED blinks at the rate decided by
the code’s delay of 1000 milli seconds in the OFF and ON period.
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h) Change the delay period and repeat the process. Observe and verify the
changes visually.

Activity 2: Interfacing the ambient temperature and humidity sensor — DHT 22
to ESP 32, and display the temperature and humidity on PC hyper terminal.

a) The pre-requisite for interfacing sensors and relating to their readings is a
careful study of their data sheets. Download and refer to the data sheet of DHT
22, to identify its functional details and measurement specifications.

b) The DHT11 and DHT22 are popular, low-cost digital sensors used to
measure ambient temperature and relative humidity in hobbyist electronics
projects. They use a single-wire digital interface for communication and consist
of a capacitive humidity sensor and a thermistor (NTC) for temperature
measurement.

444

EEEE
ASAIR® AM2302
SNi17126D42C

Figure: Sensors — DHT22 (AM2302) and DHT11

c) Key Differences: DHT11 vs. DHT22

The DHT22 is the more advanced version, offering higher accuracy and a wider
measurement range at a slightly higher cost.
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Parameter DHT11 DHT22
(AM2302)

Humidity Range 20% to 80% RH 0% to 100% RH
Humidity Accuracy H=5% RH +2% to 5% RH
Temperature Range [0°C to 50°C -40°C to 80°C
Temperature Acc. +2°C +0.5°C
Sampling Rate 1 Hz 0.5 Hz

(once per second) ((once per two seconds)
Cost Lower Higher
Resolution 1°C/ 1% RH 0.1°C/0.1% RH

d) DHT 22 Pinout and connections:

=181 =

1 VDD—power supply
3

Standard AM2302’s dimensions as above

vRD vRp
X 1Pin

MCU

1) DHT 22 and

sketch:

i1) Adafruit Unified Sensor
(if not appearing as installed)

NOTE: Make the connections for DHT 22 as shown above i.e.
+Ve or Pin 1 is connected to Vcc on the base board

- Ve or Pin 3 is connected to GND on the base board

OUT or Pin 2 is connected to D4 on the base board
KINDLY GET THE CONNECTIONS CHECKED FROM MENTORS !!

e) Install the following libraries from Tools>Manage Libraries

f) From the File menu, initiate new sketch and use the following code in the new
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//**************************************************************

// Example testing sketch for various DHT humidity/temperature sensors written by ladyada
// REQUIRES the following Arduino libraries:

// - DHT Sensor Library: https://github.com/adafruit/DHT-sensor-library

// - Adafruit Unified Sensor Lib: https://github.com/adafruit/Adafruit Sensor

#include "DHT.h"

#define DHTPIN 4  // Digital pin connected to the DHT sensor
/! Feather HUZZAH ESP8266 note: use pins 3, 4, 5, 12, 13 or 14 --
// Pin 15 can work but DHT must be disconnected during program upload.

// Uncomment whatever type you're using!

/#define DHTTYPE DHT11 //DHT 11

#define DHTTYPE DHT22 // DHT 22 (AM2302), AM2321
//#define DHTTYPE DHT21 //DHT 21 (AM2301)

// Connect pin 1 (on the left) of the sensor to +5V

// NOTE: If using a board with 3.3V logic like an Arduino Due connect pin 1
// to 3.3V instead of 5V!

// Connect pin 2 of the sensor to whatever your DHTPIN is

// Connect pin 4 (on the right) of the sensor to GROUND

// Connect a 10K resistor from pin 2 (data) to pin 1 (power) of the sensor

// Initialize DHT sensor.

/I Note that older versions of this library took an optional third parameter to

// tweak the timings for faster processors. This parameter is no longer needed
// as the current DHT reading algorithm adjusts itself to work on faster procs.
DHT dht(DHTPIN, DHTTYPE);

void setup() {
Serial.begin(9600);
Serial.printin(F("DHTxx test!"));

dht.begin();
H

void loop() {
// Wait a few seconds between measurements.
delay(2000);

// Reading temperature or humidity takes about 250 milliseconds!

// Sensor readings may also be up to 2 seconds 'old' (its a very slow sensor)
float h = dht.readHumidity();

// Read temperature as Celsius (the default)

float t = dht.readTemperature();

// Read temperature as Fahrenheit (isFahrenheit = true)

float f = dht.readTemperature(true);

/I Check if any reads failed and exit early (to try again).

if (isnan(h) || isnan(t) || isnan(f)) {
Serial.println(F("Failed to read from DHT sensor!"));
return;

}
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// Compute heat index in Fahrenheit (the default)
float hif = dht.computeHeatIndex(f, h);

// Compute heat index in Celsius (isFahreheit = false)
float hic = dht.computeHeatIndex(t, h, false);

Serial.print(F("Humidity: "));

Serial.print(h);
Serial.print(F("% Temperature: "));
Serial.print(t);
Serial.print(F("°C "));
Serial.print(f);
Serial.print(F("°F Heat index: "));
Serial.print(hic);
Serial.print(F("°C "));
Serial.print(hif);
Serial.println(F("°F"));

H

U**************************************************************

g) Verify the code and ensure no errors. Upload the code and observe the
readings on the serial terminal, provided in the IDE. Select the baud rate for
9600 baud, as specified in the code.

The output should appear similar as this:

& sketch_novi6b | Arduine IDE 2.3.6 - B8 X
File Edit Sketch Tools Help
0 e 9 4 DOITESP32DEVKITV] ~ \fk 10
sketch_noviGbing =
a efault

45 float t = dht.readTemperature(
46 Read temperat

a7 float f = dht.readTempel
48

a9 any reads faile
sa if (isnan hy || isnan(t) || isnan(f))
51 Serial.println(F("Failed to read from DHT sensor!"));

H

1n 64, Col 26 DOIT ESP32 DEVRIT VioncoM3 0 B

Discussion, and Report
Answer the following questions:
1. How can we verify the LED blink frequency to its exact value as decided
by the time period in the code ?
2. How can we rely upon or verify the readings obtained.

Result:
e LED blink basic activity completed : Yes/No
e LED blink with changes in delay demonstrated: Yes/No
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Faculty Signature & Date:

Temperature and Humidity readings displayed on hyper-terminal:
Yes/No

Conclusions:




